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Using Write to View This Document

To make this document easier to read, you can enlarge the Write window to its maximum size. To 
do so, click the Maximize button in the upper-right corner of the window. Or open the Control 
menu in the upper-left corner of the Write window (press ALT+SPACEBAR), and then choose the 
Maximize command.

To move through the document, press PAGE UP or PAGE DOWN. Or click the arrows at the top 
and bottom of the scroll bar along the right side of the Write window.

To print the document, choose Print from the File menu.

For Help on using Write, press F1.

About This Demo

This file is part of the SimCity 2000 for Windows Interactive Demo package. The real version of 
SimCity 2000 for Windows has a much more complete Read Me document. 

The SimCity 2000 for Windows Interactive Demo is a limited version of SimCity 2000. Certain 
features have been disabled or modified to make sure that even though it's a fun toy, you'll still 
want to make us happy by buying the real thing. In this demo, you are not allowed to Load or 
Save files. You may only start a new game, edit terrain, or load a demo city to give you a head-
start on seeing what can be done. Many of the sounds and musical scores have been removed, 
and all of the disasters have been removed from the menus except for fire. Additionally, there is a 
30 minute timer. After 25 minutes of gameplay, SimCity 2000 will demonstrate random disasters. 
At the 30 minute point, your current game will end and you will be returned to the New Game 
screen. All of the tools and windows normally available in SimCity 2000 are in the demo, and the 
complete SimCity 2000 Help file has been included.

To purchase the real-complete-no-holds-barred-knock-yer-socks-off version, run (don't walk) to 
your nearest software dealer and tell them you saw this nifty demo and want to buy a real version
of SimCity 2000 for Windows right now. Or, if your nearest software dealer is not within running 
distance (driving is also an acceptable mode of transport, or you could bicycle, or swim, or ride a 
Llama), you can call Maxis at 1-800-33-MAXIS tells us you want SimCity 2000 (heck, while you're
at it, why don't you order that copy of RoboSport you've always wanted!) give us your money and 
we'll ship it out to you right quick!

Technical Help

If you're having trouble running SimCity 2000 for Windows or are getting error messages (heaven



forbid!), here are some tips concerning these issues.  These tips were written by the Ninja 
Masters of Maxis Technical Support and contain enough information to make you an expert too.  
You may also be bored and want to make sure that we can actually spell and write documents 
with correct syntax.  Read on, O Seeker of Knowledge...

System Conflicts

Conflicts are rare but they can occur.  If you are using other programs in Windows that load on 
startup, you may want to disable those programs to prevent potential conflicts and free up 
additional memory and system resources.  The most common potential conflicts come from 
screen savers.  If you are using a screen saver other than the default Windows screen saver, you 
may wish to disable it to prevent conflicts.  Some virus protection programs may also conflict with 
SimCity 2000.  If you experience trouble running SimCity 2000 for Windows, try disabling virus 
protection programs.

The best way to determine if there is something else running in Windows is to press the {Ctrl} 
and {Esc} keys on your keyboard at the same time.  This will bring up the Windows Task List.

The only item shown in the Task List window should be Program Manager.  If there are any 
other items shown, and you want to disable them, simply click on the item to highlight it and click 
on the End Task button to shut the other programs off.  If there are several programs running, hit 
{Ctrl}{Esc} again, and follow the previous steps.  Do this until only Program Manager is active, 
then close the Task List window.  Now run SimCity 2000 for Windows.

Diamond Stealth 64 DRAM/VRAM
>>Important! Really Important!<< If you have a Diamond Stealth 64 VRAM or DRAM video 
card, you need to disable all "Power Saver" features (even the DOS ones)! Otherwise, your 
system may inexplicably power off while SimCity 2000 is in the foreground.

Norton Desktop For Windows
SimCity 2000 does not get along with Norton Desktop For Windows. We reccommend switching 
to the Program Manager as the default shell when running SimCity 2000 for Windows.

Sound and Music

SimCity 2000 for Windows supports all sound cards that are compatible with Windows 3.1. If you 
do not have a sound card, you will not hear sound effects or music.

If you do have a sound card, check the Options menu while playing SimCity 2000.  There are 
two menu items in the Options menu called Music and Sound Effects.  For music and sound 
effects to play, both menu items MUST be checked.

Your sound card and its Windows software must also be configured for MIDI music in order for 
SimCity 2000 to grace your ears with its sonic beauty. To check this, go into the Accessories 
group and click on the Media Player icon. Click on Device and then MIDI Sequencer, and open 
the file CANYON.MID. Click on the triangular "play" button. If you hear music, all is well and good
in the land of the Sims. If, instead, you get some kind of error message (or worse yet, no error, 
but no music) we'll need to set up your sound card to play MIDI music. Your best bet is, as 
always, to contact the dealer where you purchased the sound hardware or the manufacturer, but 
we can offer some general suggestions.

First, you'll need a MIDI driver. This is VERY card specific, but we can at least verify its presence 
without much trouble. Go into the Control Panel, usually located in the Main group. Double-click 
on Drivers. We're looking for a driver with the word "MIDI" in it, other than just "MIDI Mapper" 
(we'll need that one in a minute.) Something like "Creative SB16 MIDI" or "Voyetra SuperSAPI 



FM MIDI Driver" is a good choice.

If you see it, we're doing fine; if you don't, you will have to install whatever software driver your 
card requires; check the manual and disks that came with the card, or again, with the vendor in 
question. The installation is just so system-specific we can't be of detailed enough help.

As long as the driver is there, go ahead and Close or Cancel the Drivers and we want to open 
up the MIDI Mapper (told you we need this one!) Click on the down arrow next to Name; ideally 
we need a "Name" that lists FM, FM Synth or FM Synthesized. If you can't find such a beastie, we
can likely make one. Click on Edit under Name. Each of the sixteen Ports should be set to 
something about FM; if they're not, click on the down arrow next to Port. We want to select 
whatever option we have about FM; again, "Voyetra SuperSAPI FM" or "SoundBlaster Pro FM 
MIDI" are the kind of thing we're looking for. Choose that option for each of the sixteen channels.

The reason we want "FM" rather than "External MIDI" is that these latter would talk to an external 
MIDI keyboard or the ubiquitous Roland MT-32 unit; but you would have to have such a gizmo 
outside the computer in order to hear anything. Instead, we use your sound card to emulate this.

We also reccommend against running other sound-intensive applications (such as using the 
Media Player to play audio CD's while you play SimCity 2000).

Video, palettes and pictures

SimCity 2000 requires that your video driver be configured for at least 256 colors. It will not play 
in less. We recommend no more than 256 colors, as you may experience unusual displays if you 
are configured for more than 256 colors. HiColor and True Color users are encouraged to switch 
back to 256 colors before calling us with display problems.

Again, the configuration procedure is system-specific; you may well have an icon in your Control 
Panel or even a separate group for setting and changing resolutions (screen size) and color 
depths (number of colors). We recommend that you check with your vendor or manufacturer for 
information on your display card, but here are some general hints and tips we can run through.

Find the Windows Setup icon, usually located in the group Main. Check what you are set to for 
Display. If it's just "VGA", that means 640x480 resolution (which is fine) but 16 colors (which we 
need to change). To change, you will likely need your original Windows disks, so keep them 
handy. Go to Options and choose Change System Settings. After clicking on the down arrow 
on the far right end of the Display bar, you'll want to scroll up and down to see the available 
selections. We want one that lists specifically 256 colors. If you do, select that setting, click on OK
and insert disks as requested. Let Windows restart itself (click on Restart Windows) and off you 
go. If the driver has already been installed, you may not need the disks and you can just select 
Current when prompted.

If you have Windows for Workgroups 3.11, you should see the option for "SuperVGA"; make sure 
to select one that lists 256 colors. "SuperVGA (640x480, 256 colors)" or "SuperVGA (800x600, 
256 colors)" should be good choices. This is a generic Microsoft driver that woks with many 
cards; though it isn't optimized for your card specifically, it should get you going. If you experience
problems with it, we would recommend that you obtain a driver that is specific to your card from 
your dealer or the card's manufacturer. This Microsoft generic driver is available through many 
shareware dealers or from Microsoft.

It is possible that after Windows restarts with the new driver that your display will blank out or not 
function properly. This indicates that you will need a specific driver for your card, but here's how 
to put things back the way they were. At the C:\> prompt, go to the Windows directory (type CD\
WINDOWS {Enter}) and then start the configuration program (SETUP {Enter}). Use the up arrow
to highlight the display, then hit {Enter} and scroll down to VGA. Go back down to Accept these 



settings... and off you go. 

Nevertheless, this driver will do the trick in the majority of cases and get you up and running; 
certainly, if you have it, it's worth a whirl. Again, there's always the SimCity 2000 Help file; just 
click on the question mark icon. It's got all kinds of groovy screen shots, for one version of 
Windows anyway, with pretty pictures to make sense of what we're telling you here.

You may also see a message from the Windows Graphics package, WinG. It runs a calibration 
test the first time it installs to optimize video performance. It may warn you that it is using a slower
method of video due to "an older version" of your video card software; SimCity 2000 and WinG 
will run for now, but we would recommend obtaining an updated version of your display driver 
(one that is WinG-friendly) at your first convenience, from the dealer or manufacturer of your 
video card.

Memory Issues

SimCity 2000 for Windows requires that you run Windows in 386 Enhanced Mode (Microsoft calls
it that whether you've got a 386, 486 or a Pentium).  You can check to see if you are in Enhanced 
Mode by choosing Help in your Program Manager, then going to About Program Manager...   If 
About Program Manager says you are in Standard Mode, exit Windows, then restart with the 
command WIN/3{Enter} instead of WIN. This will force Windows to start in Enhanced Mode.  If 
you cannot run Windows in Enhanced Mode, please verify that your system meets or exceeds the
minimum system requirements printed on the system requirements label on the box your copy of 
SimCity 2000 for Windows came in.

If you're using Windows for Workgroups 3.11, the only possible mode is Enhanced, so the 
About... box won't mention mode, just free memory. This is normal and cool.

If you don't have enough memory available to run SimCity 2000 for Windows, first ensure that you
close any other program that may be running to free up the necessary memory to run SimCity 
2000 for Windows.  If this doesn't correct the problem, consult your Windows manual and refer to 
the section entitled MEMORY.  There are several different options explained within this area, from
editing your startup configuration files to using Virtual Memory.  Virtual Memory actually uses your
system's hard disk drive to temporarily store information that would normally be kept in the 
system RAM memory.  You may run Virtual Memory by following these steps:

(DON'T USE VIRTUAL MEMORY IF YOU ARE USING DISK COMPRESSION!
e.g. DoubleSpace/DriveSpace, Stacker, SuperStor, etc.  Most of these programs will come with 
their own utilities to use virtual memory, so refer to the documentation that came with your 
compression program for more information.)

1.  Open the Main window from within the Program Manager.
2.  Double-click on the Control Panel icon.  (This will open the Control Panel window.)
3.  Double-click on the Enhanced icon (the icon looks like a computer chip -- if it is not there, you 
are not running Windows in Enhanced Mode.  See the instructions above on how to start 
Windows in Enhanced Mode).
4.  Click on the Virtual Memory... button located on the right side of the window.
5.  This will open the Virtual Memory window from which you can view the current virtual memory 
settings.  You can increase the size by clicking on the Change button and increasing the size of 
virtual memory available on your system.
6.  Please see your Windows manual for more information concerning virtual memory.

Finally, if you are using Sound Effects and Music within SimCity 2000 for Windows, you will need 
as much free conventional memory as possible.  Conventional memory is memory below 640k.  
Please see your DOS manual for instructions on freeing conventional memory. If you have DOS 6
or higher, just run the MemMaker program. Type MEMMAKER {Enter} at your DOS prompt.



REMEMBER there's always the SimCity 2000 Help file; just click on the question mark icon. It's 
got all kinds of groovy screen shots, for one version of Windows anyway, with pretty pictures to 
make sense of what we're telling you here.

Installing or Running with Windows Shells other than Program Manager

Shell programs are third party replacement programs that you can use in place of the standard 
Windows Program Manager, such as HP Dashboard, the Norton Desktop, and XSoft's TabWorks 
(which comes installed on most Compaq computers).  If you are having trouble installing or 
running SimCity 2000 for Windows, try either turning off the shell you are using, or using that 
program's File - Run command to run Program Manager.  The command line to run Program 
Manager is C:\WINDOWS\PROGMAN.EXE.  Once you have installed SimCity 2000, you should 
be able to close Program Manager and run SimCity 2000 through the shell program you usually 
run.

Some shell programs simply won't let you run SimCity 2000 for Windows properly.  This will 
depend on which shell you are running.  Once you have successfully installed the program, if you 
find that SimCity 2000 still won't run, try turning off the shell program you have been using.

A Special Note About TabWorks:  If you are running TabWorks, we STRONGLY recommend the 
following procedure to eliminate problems with extraneous icon creation and other bizarre 
problems. Go to the Options menu.  Select File Tracking Options, and deselect (make sure 
there is no check mark) Track File Creation and Track File Modification.  This will allow you to 
install SimCity 2000 through TabWorks without having to run Program Manager.


